Apple Inc.

Final Cut Pro X: Exam Prep Guide and Practice Exam

Final Cut Pro Version X (10.1.2)
November 4, 2014

Produced by Apple Training & Certification. This curriculum is a product created and delivered by many individuals working at Apple, and we acknowledge them here.

We at Apple have tried to make the information contained in this course book as accurate and reliable as possible. Nevertheless, Apple disclaims any warranty of any kind, whether express or implied, as to any matter whatsoever relating to this manual, including without limitation the merchantability or fitness for any particular purpose. Apple will from time to time revise the software described in this manual and the manual itself, and reserves the right to make such changes without obligation to notify the purchaser. In no event shall Apple be liable for any indirect, special, incidental, or consequential damages arising out of purchase or use of this manual or the information contained herein.

These materials are licensed, not sold, to you. You may not sell or otherwise transfer them to any other person. No part of this publication may be reproduced, stored in a retrieval system, or transmitted in any form or by any means, electronic, mechanical, photocopying, recording or otherwise, without the prior written permission of Apple.

Copyright © 2014 Apple Inc. All Rights Reserved.

Apple, the Apple logo, AirMac, AirPort, AirPort Extreme, Apple Cinema Display, AppleScript, AppleScript Studio, Apple Studio Display, AppleTalk, AppleWorks, Aqua, A/UX, Bonjour, Carbon, Cocoa, Color, ColorSync, the ColorSync logo, DVD Studio Pro, Exposé, FairPlay, FileVault, Final Cut Pro, Final Cut Server, Final Cut Studio, FireWire, the FireWire symbol, FontSync, HyperCard, iBook, iCal, iDVD, iLife, iMac, iMovie, Inkwell, iPhoto, iPod, iPod Hi-Fi, iPod Socks, iSight, iTunes, iTunes Music Store, Jam Pack, Keychain, Keynote, LiveType, Logic Pró, Logic Remote, Mac, the Mac logo, MacBook, Macintosh, Macintosh Products Guide, Mac OS, MagSafe, MainStage, Pages, Panther, Pixlet, Quartz, QuickTime, the QuickTime logo, and Soundtrack Pro are trademarks of Apple Inc., registered in the U.S. and other countries.

Next, Enterprise Objects, NetInfo, the Next Cube Logo, NextStep, Objective-C, OpenStep, and PDO are trademarks of NeXT Software, Inc., registered in the U.S. and other countries. Mac OS X includes software developed by the University of California, Berkeley, FreeBSD, Inc., The NetBSD Foundation, Inc., and their respective contributors.

Adobe, the Adobe logo, Acrobat, the Acrobat logo, Distiller, PostScript, and the PostScript logo are trademarks or registered trademarks of Adobe Systems Incorporated in the U.S. and/or other countries.

Java and all Java-based trademarks and logos are trademarks or registered trademarks of Sun Microsystems, Inc. in the U.S. and other countries.

Windows is a registered trademark of Microsoft Corporation.

Other product and company names mentioned herein may be trademarks of their respective companies.

Mention of third-party products is for informational purposes only and constitutes neither an endorsement nor a recommendation. Apple assumes no responsibility with regard to the performance or use of these products.
# Contents

About This Guide ................................................................. 4
The Benefits of Apple Certification ........................................ 4
Preparing for the Exam ......................................................... 5
Lesson One Objectives ......................................................... 6
Lesson Two Objectives ......................................................... 7
Lesson Three Objectives ....................................................... 8
Lesson Four Objectives ......................................................... 9
Lesson Five Objectives ......................................................... 14
Lesson Six Objectives ......................................................... 16
Lesson Seven Objectives ...................................................... 19
Lesson Eight Objectives ....................................................... 21
Lesson Nine Objectives ....................................................... 22
Lesson 10 Objectives ......................................................... 23
Appendices A and B ............................................................... 24
Taking the Final Cut Pro X Certification Exam .................... 24
Exam FAQs ........................................................................ 25
About This Guide

This guide provides all the information that you need to prepare for the Apple Certified Professional-Final Cut Pro X exam to earn Apple Certified Pro certification. Certification distinguishes you among applicants to colleges or prospective clients as a skilled user of Final Cut Pro X.

The Apple Certified Professional-Final Cut Pro X exam (Exam no. 9L0-816) is a computer-based test offered at Apple Authorized Training Centers (AATCs) and online to eligible individuals who have a promotional code.

You may take up to 95 minutes to complete the exam, which consists of 75 multiple choice and interactive media questions. The questions are based on the objectives listed in this guide.

The score required to pass is 81 percent. To prepare for the exam, read through the objectives in this guide to determine which areas you need to review. The primary reference source for this exam is the Apple Pro Training Series book, Final Cut Pro X 10.1: Professional Post-Production by Brendan Boykin (ISBN 0-321-94956-0).

You aren't allowed to access any resources or references during the exam, and you may not have the application open during the exam. Please note that although this guide divides the objectives into knowledge areas, questions are presented randomly during the exam.

The Benefits of Apple Certification

The Apple Training & Certification programs are designed to keep you at the forefront of Apple's digital media technology. Certification creates a benchmark to assess your proficiency in a specific Apple Pro application. By passing an exam, you earn Apple Certified Pro status, which gives you a competitive edge in today's ever-changing job market.

What is an Apple Certified Pro?

An Apple Certified Pro is a certified user who has reached the highest skill level in the use and operation of Apple's Pro Applications as attested to by Apple.

How do I become an Apple Certified Pro?

To become an Apple Certified Pro, you must pass an online exam administered at an Apple Authorized Training Center (AATC). Apple Certified Pro certification attests to basic operational knowledge of an application. Apple Certified Pro exams are administered at the end of specific courses at the centers. Class attendance is recommended but not required.

If you prefer to learn on your own or believe you already have the necessary skill set in your chosen application, you may register to take the Apple Certified Pro exam at an Apple Authorized Training Center for a fee.

What are the benefits of being an Apple Certified Pro?

As an Apple Certified Pro, you'll be recognized as a highly skilled user of the chosen application. You'll receive a certificate from Apple,
distinguishing you as an Apple Certified Pro, and you'll have the right to use the Apple Certified Pro logo on your business cards or website—so you can leverage the power of the Apple brand.

After you pass a certification exam, you'll receive an email with a PDF certificate, along with instructions on how to order a printed or framed certificate, or both. The email also includes LinkedIn, Facebook, and Twitter icons to make it easy for you to share your certification news on social media sites.

You'll also receive instructions on how to log into the Apple Certification Records System, where you can:

- Update your profile information and opt in to display your Apple Certification(s) on the Apple Certified Professionals Registry
- Review your certification progress
- Download your certification logo(s) to use on business cards, résumé, websites, and more
- Provide access to employers to verify certifications
- Access numerous resources

Prepared for the Exam

When preparing for a certification exam it’s important to have experience with the application, review the appropriate training materials—including the Apple Pro Training Series curriculum—and study this Exam Preparation Guide. See the next section for objectives from the curriculum.

The following resources may also help you to prepare for your certification exam, as well as expand your general knowledge:

- Review the tutorials, lesson review questions, and lesson files included in Apple Pro Training Series book, Final Cut Pro X 10.1: Professional Post-Production.
- Review the appropriate sections of the Final Cut Pro manuals. The complete documentation is available at: documentation.apple.com. It's free, searchable, and linkable. You can also open the Final Cut Pro documentation by choosing Help > Final Cut Pro X Help when you launch Final Cut Pro.
- Many online resources allow you to ask questions and learn tips and tricks. To access white papers, discussion forums, and learn about the many other online materials, go to http://www.apple.com/final-cut-pro/resources/.
- For information on the Apple Pro Training Program, go to training.apple.com/.
- To provide comments and feedback to Apple about Final Cut Pro, go to http://www.apple.com/feedback/finalcutpro.html.
- Read the late-breaking news at www.apple.com/support/manuals/.
- And many third-party manufacturers create reference, troubleshooting, and online tutorials for the novice to power user.
If you have any questions, you can post them to the Final Cut Pro Discussion Forum, hosted by Apple.

Reviewing the Apple Pro Training Series curriculum

The Apple Pro Training Series book Final Cut Pro X 10.1: Professional Post-Production by Brendan Boykin (ISBN 0-321-94956-0) is part of the official training series and is designed to prepare you to pass the certification exam. So reviewing the book should be your first step in preparing for the certification exam.

If you’re self-taught or have taken courses that don’t use the Apple Pro Training Series curriculum, you can still prepare for the certification exam by making sure that you can complete all the tasks that are described in the following sections. You should also make sure that you can answer all the review questions in the book for each lesson.

Note that although this guide divides the objectives into lessons or knowledge areas, questions are presented randomly during the exam and drawn from the objectives listed below.

**Lesson One Objectives**

After completing Lesson One, “Getting Started,” you should be comfortable performing the following tasks:

- Upgrading existing events and projects
- Preparing source media files
- Listing the three phases of a Final Cut Pro editing workflow

**Lesson One review questions**

After completing Lesson One, you should be able to answer the following questions:

1. Describe the three post-production workflow phases in Final Cut Pro.
2. When Final Cut Pro asks if you want to update your projects and events to Final Cut Pro X 10.1, what options are available?
3. Should you update any post-production software during an editing job in progress?

**Answers**

1. Import: The ingest process of storing your story’s source media files and organizing the clips that represent those source files. Edit: The creative process of assembling, trimming, and effecting clips to tell a story. Share: The export process of distributing your completed story to various platforms.
2. The options presented are to upgrade all projects and events into one library per volume, to allow you to selectively upgrade now, or to return to the upgrade process later.
3. A common practice in the post-production industry is to not update software, and in some cases hardware, while working on an editing job.

Lesson Two Objectives
After completing Lesson Two, “Importing Media,” you should be comfortable performing the following tasks:

- Defining the clip, event, and library containers
- Differentiating between managed and external media files
- Creating a camera archive
- Importing files using Media Import and the Finder

Lesson Two review questions
After completing Lesson Two, you should be able to answer the following questions:

1. Which of these three is the largest media container: Clip, event, or library?
2. Describe possible organizational criteria for sorting clips and projects into events.
3. Name and describe the built-in command for backing up camera media files.
4. Where should you store camera archives?
5. What two views are available in the Media Import window, and when are the two views available?
6. What setting on the Zoom slider in filmstrip view allows you to see each clip as a single thumbnail?
7. What keyboard shortcuts or modified-skimming keys let you mark multiple range selections within a clip?
8. In the Media Import Options dialog, which of these two sections sets media files as managed or external?
   A:
   - Add to existing event: [ ] Primary Media
   - Create new event in: [ ] Lifted library

   B:
   - Files: [ ] Copy to library
   - Leave files in place

9. Fill in the blank: With the “Create optimized media” option selected, Final Cut Pro X transcodes imported media to the ________ codec.
10. When dragging items from the Finder to an event, where do you set the option to copy (or not copy) the photo into the Library?

11. You’re about to import source media files grouped into various folders. Which Media Import option must be selected to replicate the folder structure within an event?

**Answers**

1. The library is the largest of the media containers.

2. The criteria are whatever you choose: A scene of a film, a segment of a news-magazine show, a webisode, stock footage, raw media from an SD card, all versions of the projects, and so on. An event is a flexible storage container that can be as all-encompassing or as granularly compartmentalized as your raw media and projects.

3. The Create Archive command creates a clone of your source media device, preserving the folder structure and metadata along with the source media files.

4. Camera archives may be stored anywhere. However, to reduce the chance of a single-point failure taking down an entire editing job, camera archives should be stored on a volume physically separate from the media storage volume you use for editing.

5. Filmstrip and list view. The two views are available when importing from a recognized camera card file structure. Otherwise, only the list view is available in the browser of the Media Import window.

6. All. The setting defines the time length represented by each thumbnail of the clip.

7. The keyboard shortcuts are Command-Shift-I and Command-Shift-O. Holding down Command while skimming a clip also marks ranges.

8. B. “Copy to library” creates managed media while “Leave files in place” creates externally referenced media.

9. Apple ProRes 422

10. Final Cut Pro > Preferences

11. “From folders”

**Lesson Three Objectives**

After completing Lesson Three, “Organizing Clips,” you should be comfortable performing the following tasks:

- Applying keywords to a clip and clip ranges
- Searching and filtering clips by keywords
- Adding notes and ratings to a clip
- Creating Smart Collections
- Detecting people and composition within clips
- Identifying and assigning roles
Lesson Three review questions
After completing Lesson Three, you should be able to answer the following questions:

1. When applying keywords to a clip, may keywords be overlapped?
2. Which inspector can you use to add notes to a clip?
3. All clips start with which rating assigned?
4. What default filter setting prevents Rejected clip ranges from appearing in the Browser?
5. You’re trying to find a clip you imported into the library. How can you find it?
6. What procedure is necessary to search an event using a combination of keywords?
7. How do you edit the criteria rules for an existing Smart Collection?
8. At what point in the workflow may a clip be assigned a role?

Answers
1. Yes
2. The Info inspector
3. Unrated
4. Hide Rejected
5. In the Libraries pane, select the Library. From the Filter pop-up menu, choose All Clips. Clear the Browser’s search field.
6. Keyword combinations are searchable only by clicking the magnifying glass in the search field and using the Keywords criteria rule in the Filter HUD.
7. In the Libraries pane, double-click the Smart Collection.
8. Clips may be assigned a role at any time in the workflow. However, roles assigned to clips shortly after import are carried with the clip throughout the editing workflow.

Lesson Four Objectives
After completing Lesson Four, “Making the First Edit,” you should be comfortable performing the following tasks:

- Creating a project
- Adding and rearranging clips within a primary storyline
- Ripple, Roll, and Slip trimming clips
- Using the Blade tool, replacing with a gap clip, ripple deleting, and joining through edit
- Performing connect edits
- Creating and editing in a connected storyline
• Adjusting audio levels
• Sharing the project to a media file

Lesson Four review questions
After completing Lesson Four, you should be able to answer the following questions:

1. What do the Automatic Settings do when creating a new project?
2. Where are projects stored?
3. Which edit command is depicted in the image below?

4. Which edit command is depicted in the image below?

5. Which toolbar button performs an append edit?
6. In the image below, what do the green-, blue-, and purple-colored stripes overlaying the clip identify?

7. When in filmstrip view, which modifier key do you hold down to edit clips into the project in the order that you select the clips in the Browser?
8. When performing an insert edit, what marks the Timeline location for the edit: The playhead or the skimmer?
9. Identify the trim type used in the image below.

10. Which two interface items provide additional skimming precision in the Browser?

11. In the image below, what does the Viewer overlay indicate?

12. With the primary storyline determining the project’s timing, what generic clip can be inserted to “create” time between storyline clips?

13. In the image below, what type of edit was performed in one command?
   Before:
14. In the images below, identify the edit functions indicated by the mouse pointer
   A: 

   B: 

   C: 

15. To append edit a clip into a connected story, what must be selected and what must not be selected before pressing E?
16. What does the “-15 dB” indicate in the image below?

![Image]

17. Identify the interface element that displays the Audio meters.

18. Using the image below for reference, describe what will occur during playback of this transition.

![Image]

19. Which interface element can you use to export a file of your project that’s compatible with iOS and Apple TV?

**Answers**

1. Automatic Settings conform the project’s resolution and frame rate to the first video clip added to the project.

2. Projects are stored within a designated event.

3. Append

4. Insert
5. The append edit button

6. Favorite, user-applied keyword, and analysis keyword

7. Command

8. The skimmer, if active. Otherwise, the playhead.

9. Ripple trim

10. With the Zoom slider, you can see more clip content horizontally, and with Clip Appearance, you can increase clip height and hide and view waveforms.

11. The playhead or skimmer is cued to the start frame of a clip.

12. A gap clip

13. Replace with Gap or Lift edit (keyboard shortcut: Shift-Delete)

14. A: Ripple  
   B: Roll  
   C: Slip

15. The connected storyline’s handle must be selected, but not any clip inside the connected storyline.

16. The audio volume control has been lowered to play the audio clip 15 dB quieter than the audio clip’s recorded level.

17. Show/hide the audio meters in the Timeline pane

18. The GOPR0009 clip will fade in from black, but halfway through the transition, Mitch’s interview will cut in and be visible until the GoPro clip becomes fully opaque.

19. The share pop-up menu

Lesson Five Objectives

After completing Lesson Five, “Revising the Edit,” you should be comfortable performing the following tasks:

- Defining and distinguishing the two types of project duplication
- Explaining the replace edit options
• Using the Dashboard for playhead positioning
• Using markers for clip synchronization and task notes
• Creating and editing with an audition clip
• Refining a project using trim to playhead and trim to selection

Lesson Five review questions
After completing Lesson Five, you should be able to answer the following questions:

1. Describe the results of using the following commands: “Duplicate Project as Snapshot,” and Duplicate Project.

2. Which replace edit command replaces the project clip using the duration of the browser clip: Replace, “Replace from Start,” or “Replace from End”?

3. Identify and define (from left to right) the four buttons in the image below.

4. In the image below, what action results from the displayed indication in the Dashboard?

5. Where do you find a list of all markers used in a project?

6. What command was invoked in the project displayed in the image below?

7. Which tool repositions storyline clips relative to time, allowing a clip to overwrite other clips?
8. Where may you assign a role to a clip?
9. What types of clips may go into an audition?
10. What icon badge identifies an audition clip?

11. What command was used in the scenario shown below?

![Before and After]

Answers

1. Duplicate Project: Creates a “live” version that updates its compound and multicam clips used in other projects. “Duplicate Project as Snapshot”: Produces a complete freeze of the project at the time of the duplication.

2. The Replace edit command

3. Skimming (S): Enable/disable the video skimmer. Audio Skimming (Shift-S): Enable/disable audio skimming (skimming must be enabled). Solo (Option-S): Monitor the audio playback of the selected clip(s). Snapping (N): Magnetically align the skimmer/playhead while dragging to the start of clips, keyframes, and markers.

4. The playhead will move three seconds to the left. This adjustment was performed by pressing Control-P.

5. The Tags Index found in the Timeline Index pane

6. The Solo command, Option-S

7. Position tool

8. Roles may be assigned in the Info inspector or in the Modify menu.

9. Commonly used for multiple takes of an on-camera performance or of an audio-only VO, the audition clip collects whatever clip types you add to the audition.

10. A spotlight badge identifies and is an access point to an audition clip.

11. Trim to Selection, Option-\`

Lesson Six Objectives

After completing Lesson Six, “Enhancing the Edit,” you should be comfortable performing the following tasks:

• Varying the playback speed of clips
• Modifying the look of clips with effects
• Utilizing transitions
• Adjusting transform and compositing controls
• Creating compound clips

Lesson Six review questions
After completing Lesson Six, you should be able to answer the following questions:

1. Which interface items allow access to the Custom Speed window?
2. What command allows you to experiment with a storyline clip's retiming without creating a rippling effect on later clips in the storyline?
3. You've manually set the retiming rate for a clip, but at this rate, the clip is too long for the time slot in the project. Which interface item allows you to trim the clip without changing the playback speed?
4. Which command was used to create the retiming effect shown in the image below?

![Image of retiming effect]

5. How do you access an effect's parameters to adjust the look (or sound) of that effect?
6. What are the steps to reset an effect's parameters, disable the effect, and delete an effect from a clip?
7. What does the red bracket indicate in the image below?

![Image with red bracket]

8. Referring to the image in question 7, describe two ways to create the media handles necessary to apply a 1-second transition.
9. Which of the images below indicates that you're ready to adjust the duration's transition?

![Images of media handles]

10. How do you replace a project transition with a transition from the Transition Browser?
11. Which two interface elements may be used to activate the Viewer's onscreen Transform controls?
12. Describe the difference between Paste and Paste Attributes.
13. How do you access the individual components of a compound clip?

Answers

1. Retime pop-up menu

2. Use the “Lift from Storyline” command to convert the clip to a connected clip. With this command, you can change the speed and duration of the clip without disturbing later clips.

3. Ripple trim changes the clip’s duration without changing the set speed rate.

4. The Blade Speed command from the Retime pop-up menu

5. First, the effect must be applied to a project clip. Second, the clip must be selected or the playhead cued over the clip to access the parameters in the Inspector pane.

6. Reset the parameters by clicking the effect’s Reset button (the hooked arrow).

7. The starting clip doesn’t have an adequate media handle to apply a transition.
8. Use the Slip trim tool and drag left on the starting clip. Or, using the Roll trim tool, drag the edit point right to create a media handle prior to the clip’s start point. The use of either method depends on available media handles on the opposite point—the end of the starting clip and the end of the ending clip, respectively.

9. C

10. You may drag the new transition to the existing transition similar to performing a replace edit. Or, with the existing transition selected, double-click the new transition in the Transition Browser.

11. In the Viewer

12. Paste: Applies the copied clip and its attributes, similar to a replace edit. Paste Attributes: Allows you to select the desired attributes of the copied clip—such as a particular effect or a specific parameter such as speed—to apply to another clip.

13. Double-click the compound clip

Lesson Seven Objectives
After completing Lesson Seven, “Finishing the Edit,” you should be comfortable performing the following tasks:

- Adding and modifying a lower third
- Split edit audio and video
- Keyframing audio
- Color correcting a clip

Lesson Seven review questions
After completing Lesson Seven, you should be able to answer the following questions:

1. What happens when you double-click a title in a project?
2. What key should be pressed to exit text entry in the Viewer?
3. What type of audio clip may be trimmed at the subframe level?
4. What modifier key used with the Select tool will create audio keyframes?
5. What command creates a split edit without creating an accidental sync offset in the Timeline?

6. What function turns the skimmer into an “audio solo” skimmer?

7. Where can you switch a clip's audio channels from stereo to dual mono?

8. Your Timeline looks like the image below, and not all of the audio clips are audible. What should you do to hear and “see” all of the clips?

9. What tool prepares a section of an audio clip to receive four keyframes?

10. Compare the difference between a color balance based on Not Analyzed and Analyzed status.

11. Which video scope measures brightness (luma) based on the grayscale of the entire image?

12. Looking at a clip's image in the Viewer, the brightest parts of the image have a slight blue tint. How do you remove the tint?

Answers

1. The title is selected, the playhead cues to a frame where the text elements are visible, and the first line of text is automatically selected, ready for text entry.

2. Press the Escape key to exit text entry

3. An audio-only, connected clip or an audio/video expanded clip may be trimmed at the subframe level.

4. Option

5. Expand Audio/Video

6. Clip Skimming

7. With the clip selected, the Channel Configuration section of the Audio inspector

8. Look in the Timeline Index for roles that have been minimized and deselected (disabled)

9. Range Selection
10. Color balancing a Not Analyzed clip will create the color balance calculation based on the frame under the playhead. With an Analyzed clip, the color balance correction is based on the average color cast in the entire clip.

11. Waveform

12. In the Color Board, drag the Highlights puck toward positive yellow, or drag the Highlights puck down toward negative blue.

Lesson Eight Objectives

After completing Lesson Eight, “Sharing a Project,” you should be comfortable performing the following tasks:

- Exporting to a media file
- Posting media to an online host
- Creating a bundle for multiple platforms
- Explaining the XML workflow
- Identifying and distinguishing the two Compressor export options

Lesson Eight review questions

After completing Lesson Eight, you should be able to answer the following questions:

1. Which Share window button do you click to display the compatible platforms for the current export settings?

2. When sharing to an online host, which interface item displays details about the upload’s progress?

3. Where can you find a history of a project’s shared instances?

4. Which destination preset allows you to distribute to multiple platforms in a single share session?

5. Which Master File Settings parameter allows you to export audio stems from inside a QuickTime movie?

6. What export command outputs your project to a file format readable by several third-party applications?

7. Name two export methods that utilize Compressor custom settings.

8. Of the two export methods described in question 7, which one uses Compressor’s distribute processing capabilities?
Answers

1. The Share window’s compatibility checker

2. Click the Background Tasks button in the Dashboard to see details of the upload’s progress.

3. With the project selected in the Browser, look in the Share inspector

4. The Bundle destination preset

5. Roles as: Multitrack QuickTime Movie

6. File > Export Project XML

7. The Compressor Settings destination preset in the Share pop-up menu and the File > Send to Compressor command

8. File > Send to Compressor

Lesson Nine Objectives

After completing Lesson Nine, “Managing Libraries,” you should be comfortable performing the following tasks:

- Differentiating external and managed media
- Importing as managed and external media
- Moving and copying clips within and between libraries

Lesson Nine review questions

After completing Lesson Nine, you should be able to answer the following questions:

1. Define and compare managed media and external media.

2. How is external media referenced in an event?

3. What media storage selection do you choose to define media as external?
4. How can you find the File Information section shown in the image below?

![File Information](image)

5. When archiving or preparing a library for transport, describe a few tasks you should complete.

**Answers**

1. Managed media files gives Final Cut Pro the responsibility of storing your source media files inside the library you designate. Storing media externally saddles you with the responsibility of watching over the source media files. In either case, you determine where the media files are physically stored. The difference is who’s responsible for tracking that media: Final Cut Pro or you.

2. External media is referenced inside an event through the use of symlinks.

3. The first answer is “Leave files in place”; however, “Copy files into” can designate an external folder outside a library, which would also result in external media.

4. With the event selected in the Libraries pane, you’ll find File Information in the Info inspector.

5. Consolidate the library as a managed library, delete render files, and don’t include optimized or proxy media.

**Lesson 10 Objectives**

After completing Lesson 10, “Advancing Your Workflow,” you should be comfortable performing the following tasks:

- Identifying manual options for new projects
- Synchronizing dual system recordings
- Creating a chroma key
- Explaining the multicam workflow

**Lesson 10 review questions**

After completing Lesson 10, you should be able to answer the following questions:

1. Which project Video Properties parameter must be selected to edit in a nonnative video resolution?

2. Identify the default render format in Final Cut Pro.
3. What command creates a compound clip that synchronizes a video clip and an audio clip recorded on separate devices?

4. What command allows you to manually adjust the synchronization of audio and video within a clip?

5. In what vertical order should clips be placed for compositing?

6. In the Keyer effect, what parameter should you set to disable the auto-keyer and gain manual control over the settings?

7. Fill in the blank: Double-clicking a multicam clip opens the ________.

8. What button do you click to display a multicam clip's angles for monitoring and to choose the active angle during playback?

9. What do the three active angle colors indicate?

Answers

1. The Format parameter must be set to Custom using the manual settings.

2. Apple ProRes 422

3. Synchronize Clips

4. Open in Timeline

5. The foreground clip should be placed in a lane above the background clip.

6. Set the Strength slider to 0

7. Angle Editor

8. Clicking Show Angles reveals the Angle Viewer

9. Yellow indicates the active video and audio angle. Blue indicates the active video angle. Green indicates the active audio angle.

Appendices A and B

**Final Cut Pro X 10.1: Professional Post-Production** includes 10 lessons and two appendices. The content in the appendices isn't covered on the end user exam. But all lessons and appendices are included on the trainer version of the exam.

Taking the Final Cut Pro X Certification Exam

The **Apple Certified Professional-Final Cut Pro X** certification exam must be taken at an Apple Authorized Training Center (AATC) in a proctored setting. To find the closest AATC, go to [training.apple.com/aatc](http://training.apple.com/aatc).

Many AATCs schedule “Certification Exam Sessions” at [training.apple.com/schedule](http://training.apple.com/schedule). If you don't see a session scheduled, you can contact the AATC and they'll often schedule one for you. Please note that all AATCs can offer all Mac OS X and Pro Apps exams, even if they don't offer the corresponding course.
Exam FAQs

Why do I need to register on the Pearson VUE site?
Pearson VUE is a third-party company that facilitates Apple's online exams. Registration on the site is required to register to take an exam.

What is a voucher code?
A voucher code allows you to take an exam without having to enter credit card information. This unique code is good for only one use. Voucher codes are given to AATCs, and they'll give one to you.

How much can an AATC charge me for a certification exam?
Training Centers can choose to include the exam costs in their course fee or they may choose to charge separately. If they charge separately for the exam, the suggested price is US $250.

How long must I wait before retaking a certification exam if I fail?
You don’t need to wait to take the certification exam after taking the practice exam, even if you fail the practice exam. For certification exams, candidates are limited to one try per week. Pearson VUE defines one week as seven 24-hour periods after you ended your first attempt.

Do I have to pay to retake an exam?
It’s up to the AATC to decide how they want to handle this. They can absorb the cost of the exam, charge you, or charge you and credit the costs toward another class. You should learn the retake policy for the AATC where you plan to take the exam.

How do I make my listing appear?
After passing your exam, you’ll receive an email with a PDF certificate, along with instructions on how to order a printed certificate. Please allow up to two weeks for your exam records to be available in the Apple Certification Records System (ACRS) at http://training.apple.com/acrs. If this is your first Apple Certification, you’ll receive an account activation email.

You can then log in to the Apple Certification Records System to update your profile information and opt in to display your Apple Certification(s) on the Apple Certified Professionals Registry. Note that your certification isn’t automatically published. You must opt in for it to appear.

Can I take an exam without taking a class?
Yes, if you believe that you already have the required knowledge, you can take an exam without attending the recommended course.

Do you offer any accommodations to students under the Americans with Disabilities Act (ADA) for the exams?
We offer accommodations to students under the Americans with Disabilities Act (ADA). Students with qualified conditions such as blindness, dyslexia, deafness, and quadriplegia may be eligible for time extensions when taking a certification exam. If you believe that you’re eligible, send the details to your AATC at least seven business days before you want to take the exam. If you qualify under the guidelines, Apple will
provide an exam code that will allow you the appropriate time extension. Your AATC can provide you with a list of qualified conditions and standard accommodations that are in accordance with the ADA.